ALP LHCSA Statistical Report and Registration Forms on Universal Data Collection System (UDCS)
Instructions

Submit this report with information regarding the residents your LHCSA (Licensed Home Care Services
Agency) serves in the ALP (Assisted Living Program) only. If your LHCSA also serves patients in the
community, you must also submit the LHCSA Statistical Report.

Please see Attachment A at the end of this document — it contains descriptions to all items on the tool bars
located on the top of the Report Manager worksheets.

General Information:

e Enter information in the blank white fields. All other fields (pink, lavender, and brown) are read-only
fields. You can leave white fields blank if you have nothing to report — you do not have to enter zeros.

e A few fields are required. If they are left blank, you will not be able to submit the report. The field
header will indicate that the field is required.

e Some fields require a Yes or No answer. You must double click on the blank field and choose Yes or
No from the box.

e Some forms have validation edits to ensure accurate information is collected. The validation edits are
described in these instructions.

To Begin:

Once you have downloaded the Report Manager software and report shell (see the separate downloading
instruction document):

e To start a new report, click on the Start New Report icon or to resume working on a previously saved

report click on the Open Existing Report icon.

Note: This documentation has been updated from the version used for the 2018 LHCSA Statistical
Report. Dates in the text have been adjusted to reflect this. However, the dates in the graphics have not
been changed and should be mentally adjusted to reflect the new time period.
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Once you have started a new report or opened an existing report, a box will pop up which is the Configure
Report Organization. In this box, you will select your organizations name from the drop-down box in the
organization line. If your organization is not listed in the drop-down click on the box that states Organization
Not found In List for further instruction. In region section you will have to select statewide. Then click OK.

Organization

Region

Submission Period

Report Duration

Configure Report Organization

| v|
‘ v‘

Annual

01/01/2018 - 12/31/2018

Organization Not Found In List | . oK | cancel

You will then see a report configuration box. Click the Next tab in the bottom right corner.

a5 Report Configuration

Report Types

Select a Report Type

Class Code Line Number
999810000| |1

ALP LHCSA
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A second report configuration box will appear once you have completed selecting your counties of service.
Click Finish in the bottom right hand corner.

5 Repert Configuration =

Report Configuration Complete

<Back | Finish

The Save Report Configuration box will come up next to show you where your report is being stored on your
computer. You can change where you want it stored by clicking the change location button.

Save Report Configuration *

Organization Mame 00 TEST LHCSA (000000LC)
Region STATEWIDE

Report Types ALP LHCSA

Submission Period ANMUAL

Report Duration 01/01/2018 - 12/31/2018

PNP File Name ALP_LHCSA_00_ TEST_LHCSA_(000000LC)_STATEWIDE_2018_AO0 " PNP
Location CMNUSE ME U PO HCSA L
\USERS\NBS0&6\DOCUMENTS\UDCS\REPORT\L \Y Cha ion
oK Cancel
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General Information Form

The General Information Form is part of the Report Manager Software and collects information about your
organization that not only identifies you but enables the submission and certification of your report as well as
the successful transfer of your data to a data repository.

When you open the report, you will receive a pop-up box that requests that you fill in the General Information
Form. You must fill in the General Information Form prior to submitting the report.

@l General Information Validation Message — O X

6! Report General Information Form - O X

General Information Form

Configuration Information

Class Code Line Number

Submission Type : | 53m| |35 | |nLP_I.HCSA |
Submission Year : | o] [1010 | [2018 |
Submission Period : | 0| [1011 | [pot |
ocn: R |
Submitter ID : | 5300] |1 | 120011234 |
Region ID : | 5.=m| |B | |1 |
Region Mame : | 53m| |zz | |STATEWIDE |
Name of Organization : | 53m| |z | |chs TEST ORG NAME - 1 (120011234) |
Begin Date : | 5300 [29 | 0170172018 -

End Date : | 5300] [30 | 1273172008 -
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Contact Person

Class Code Line Number

Name : [ 54000 [ | | o
Title : | 54000] [4 | | o
Telephone Number : | 54000] [5 | | o
Fax Number : [ 54000 6 | | |

E-mail Address : [ 54000 [7 | | o

Mailing Address
Class Code Line Number
Street Address : [ 54000 i1 | | o
chy: [ ssosf[z | @
State : | 54000 13 | &
Zip Code : [ 54000 [14 | | |
Validate  Save | Cancel |

The General Information Form information section will be filled in for you. You only need to fill in the
Contact Person and Address sections.
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Form ALP1 — Agency Form

Form ALP1 - Agency Form collects agency location, contact information and other information.

ALP1 Agency Form Contact Information

10000 10001 10002

License Number | 00001

Mational Provider Identification Mumber 00002
Federal Employer Identification Mumber (FEIN) | 00026
Agency Name | 00003

Street Address 00004

City | 00005

State 00006

Zip | 00007

Agency Phone Mumber | 00008
Contact Person 00009

Contact Person Email 00010

Agency and Contact Information Section
All fields in this section, except for NPI number, are required fields. You will not be able to submit the
statistical report if this information is not filled in.

Send questions to hcstatrpts@health.ny.gov pg. 7



Form ALP2 — Resident Form

Form ALP2 - Resident Form collects resident demographic information, including discharges and referrals.

ALP2 Resident Form
Report Type : ALP_LHCSA

ALP2 Resident Form Residents Male Female Length of Stay Admitted From Discharged To
20000 20001 20002 20003 20004 20005 20006 20007
Residents Residents

Resident Census on December 31 of Report Year | 00001
Number of Unduplicated Residents | 00002
Resident Information by Age/Sex

MNumber of Residents as of December 31 or Date of
Male Female

Discharge
Residents aged 1-21 | 00003
Residents aged 22-64 | 00004
Residents aged 65-74 | 00005
Residents aged 75-84 | 00006
Residents aged 85 and over | 00007
Total Number of Residents | 00009
Length of Stay
For Discharged Residents: Residents/LOS

MNumber of Residents with a Length of Stay less than &
maonths

MNumber of Residents with a Length of Stay of -12 months | 00012
Mumber of Residents with a Length of Stay of 13-24 months | 00013

Mumber of Residents with a Length of Stay of more than 24
months

Total Residents | 00020

00011

00014

Admitted From or Discharged To

Mumber of Cases Admitted from or Discharged to: Admitted From Discharged To

Hospital | 00022

SelffFamily/Friend | 00023

Adult Care Facility | 00024

Mursing Home | 00025

Other | 00026

Number of Residents Discharged to Death | 00028

Total Cases | 00030

Some of the totals on this form are automatically calculated — they are the lavender fields.

Residents Section
Enter information for Resident Census. Enter the resident census as of December 31 of the report year
(12/31/2019). Resident Census means the actual number of individual residents receiving services.

Enter the Unduplicated Resident Count in the next field. This is the total number of discrete individual
residents that your agency has served in the year, regardless of the number of admissions and discharges that
resident may have had. A resident is only counted once regardless of the number of cases they represent.

To recap, if a resident is receiving care on 12/31/2019 they will be included in the resident census count. If
they had two admissions during the year, they will count as two cases but as only one unduplicated resident.

Length of Stay Section

Length of Stay (LOS) information is entered in the next section. LOS is calculated for each episode of care or
case. Length of stay should be calculated from the date the resident was initially admitted for an episode of
care, regardless of the year of admission, to the date they were discharged. For example, if a resident was
admitted on 12/30/2018 and discharged on 1/10/2019 her LOS is 12 days. Count the 2 days in 2018 and the
10 days in 2019 to arrive at a 12 day LOS. Residents that were discharged to a hospital or RHCF and
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readmitted to the agency within 30 days with the same illness or diagnosis should NOT be counted in the
length of stay section.

Validation Edit - The total number of discharges calculated from the LOS entries on row 20 of ALP2 must
match the total number of discharges calculated from the “Discharged To” section on row 30 of ALP2.

Referrals and Discharges Section

The next section collects resident referral and discharge information. In the “Referred From” column enter the
number of cases served by your agency that have been referred from each of the designated sources regardless
of their start of service date. This means that if you are serving a case in 2019 that was referred to your agency
in 2018, that case should be counted. Residents that were discharged to a hospital or RHCF and readmitted to
the agency within 30 days with the same illness or diagnosis should not be counted in the discharge section.

In the “Discharged To” column enter the number of cases discharged during the reporting year to specific
destinations.
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ALP3 — Cost Form

ALP3 — Cost Form - collects data on revenue and costs for providing services to residents.

ALP3 Cost Form
Report Type : ALP_LHCSA

ALP3 Cost Form
30000

Total Mumber of Days of Care

Total Revenue

Average Revenue per day of Care (Calculated by System)

Total Costs

Capital and Related Costs

Operational Costs (Calculated by System)

Average Operational Costs per Days of Care (Calculated by System)
Administrative and General Costs

Administrative and General Costs Ratio of Operating Costs (Calculated by System)
Home Health Aide Costs

Personal Care Aide Costs

Total HHA and PCA Costs (Calculated by System)

Administrative and General Costs Ratio applied to total HHA + PCA Costs (Calculated
by System)

Some of the totals on this form are automatically calculated — they are the lavender fields.

30001

00001
00002
00003

00005
00006
00007
00008

00010
00011
00012

00013

Total
30002

One lines 1 and 2 enter the total number of days of care and total revenue for the report year.

On line 3 the system will calculate the average revenue per day of care by dividing the revenue by the days of

care.

Enter total costs for the report year on line 4 and the amount of capital related costs on line 5.

e C(Capital and Related costs are onetime costs for construction, major repairs to real estate owned by the

agency, etc.

On line 6 the system will calculate Operational Costs by subtracting the amount of capital costs from the total

costs.

On line 7 the system will calculate the average operational costs per days of care by dividing the operational

costs by the total number of days of care.

Enter the Administrative and General Costs of line 8

Send questions to hcstatrpts@health.ny.gov
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e Administrative and General costs are expenses for activities and materials that are used to administer
your business. Examples are rent, utilities, and office supplies.

On line 9 the system will calculate a percentage by dividing the administrative costs by the operating costs.
On line 10 and 11 enter the costs to provide Home Health Aide and Personal Care Aide services.
On line 12 the system will calculate total HHA and PCA Costs.

On line 13 the system will apply the percentage from Line 9 to the total HHA and PCA costs on line 12.
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ALP4 — Staff and Wages Form

ALP4 — Staff and Wages Form - collects information by staff type for full time and hourly staff at two
different dates during the reporting year and the total number of W2s issued, hours worked, wages, and fringe
benefits.

ALP4 Staffing and Wages
Report Type : ALP_LHCSA
Estimated
Number of Number of Average
Percentage ) Number of ) Number of Average -
ALP4 Staffing and Wages of Staff Time Full Time Hourly Staff Full Time Hourly Staff Numb.er of Number of Number of | Number of Staff Wages Frlng.e Total . Num.ber of
Staff on " Starr on Full Time Staff Hours FTEs Benefits Compensation W2s issued
Spent on Apri on April 1 on October 1 Hourly Staff
pril 1 October 1 Staff
LHCSA
40000 40001 40002 40003 40004 40005 40006 40007 40008 40009 40010 40011 40012 40013 40014

Director/Administrator | 00001
Other Administrative Staff | 00002
Mursing Supervision Staff | 00003

HHA Staff | 00004
PCA staff | 00005

Some of the totals on this form are automatically calculated — they are the lavender fields.

Enter the number of full-time and hourly staff at your agency on April 1 and October 1. The current definition
of a full-time staff is someone who works an average of 30 or more hours a week and 130 hours or more per
month. The form will calculate the average number of full time and part time staff in the first two lavender

columns.

Enter the total hours worked for the year. The form will calculate the number of FTEs represented by these
hours by dividing the number of hours by 2,080.

Enter total wages paid, and total fringe benefits paid for each staff type. The amount of wages plus fringe
benefits will be calculated.

Enter the number of W2s issued during the year for each staff type.
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ALPIWFC — Workforce Form C

ALPIWFC — Workforce Form C - collects employee benefit information for four types of employees, and
non-wage supports for all staff.

This form requires some Yes or No Responses. To answer Yes or No, double click on the white field and the
following box will pop up.

ol YESMO ®

Search || |

Name
Yes
No

Current value for cell [

{no value has been assigned} Ok Cancel

Choose your yes or no response to the question, click OK, and it will populate in the field.
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HHAs

Homemakers
and
Housekeepers

How many employees are enrolled in
employer-provided health insurance as of
October 17

How many employees have paid sick/vacation
leave as of October 17

How many employees have access to employer
sponsored retirement plans as of October 17

How many employees have short term disability
insurance which the agency pays at least part of
the premium as of October 17

How many employees have filed Workers
Compensation claims during the reporting year?

health insurance?

Transportation Support 00008

Childcare Support 00009

hentoring 00010

Benefit Assistance 00011

Scholarships 00012
Does the agency pay increased wages for

employees filling cases on weekends, holidays, 00014
or for complex cases?

Does the agency offer employer-provided 00015

Employees that receive health insurance or retirement plan benefits through the union, if the agency pays into
the benefit, should be counted as enrolled in employer-provided health insurance or employer-sponsored

retirement plan.

Short-term disability insurance may include the required coverage under New York State law or supplemental

coverage that the agency offers.
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ALP10 - Registration Form

ALP10 — Registration Form - collects an attestation that indicates the ALP LHCSA is currently operational
and serving residents. If the ALP LHCSA has opened in the past year, you can report on the form that the

ALP LHCSA is not yet operational and is currently not seeing residents.

Some fields on this form are required fields. You will not be able to submit the statistical report if this

information is not filled in.

The appropriate Governing Authority Agent must request that the ALP LHCSA be registered with the

Department of Health for the upcoming calendar year.

ALP10 Registration Form
Report Type : ALP_LHCSA

ALP10 Registration Form
100000

Today's Date
LHCSA Operator Name
LHCSA Administrator Name

Did this ALP LHCSA provide resident care services during the report year of 1/1/2018-12/31/20187
Did this ALP LHCSA provide resident care services during any partion of 20197
Does this ALP LHCSA intend to provide resident care services in 20207

Has this ALP LHCSA been open less than one year from today's date and has not served residents during this
timeperiod?
Date the ALP LHCSA Opened

Has this ALP LHCSA received payment for Mursing, HHA, or PCA services during the report year of
1/1/2018-12/31/20187

No Licensed Home Care Services Agency shall be permitted to operate, provide nursing, persnoal care aide
services or home health aide services

or receive payment for such services from any payor unless it is registered with the NYS Department of
Health.

Do you wish to register this ALP LHCSA with the MNYS Dept of Health for the period 1/1/2020-12/31/20207

By answering yes, | attest that all of the responses to this statistical report are true and correct to the best of my
knowledge.

| understand that falsifying a statistical report may subject me to fines and/or sanctions under Section 210.45 of the
Penal law and may invalidate the registration of the agency.

Mame of Governing Authority Representative submitting this report:

The deadline to submit the Registration Form (ALP10) for the period beginning January 1, 2020 is November
16, 2019.

Failure to submit an accurate Registration Form (ALP10) by November 16, 2019 will result in a penalty of five
hundred dollars ($500) for each month or part thereof that the ALP LHCSA is in default.

An ALP LHCSA will not be allowed to register for the following registration period unless it submits any
unpaid late fees.

The Department shall institute proceedings to revoke the license of any ALP LHCSA that fails to register for
two annual periods whether or not the periods are consecutive.
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00001
00002
00003

00005
00006

00007
00008

00010

00011

00012

00013

00020
00014

00015

00016

00017

00018

Response
100002

MName and Date

Yes/No

Yes/No and Date

Yes/No

Yes/No (Required)

Yes/No and Mame (Required)
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Validating the Statistical Report

You may, at any time, validate the sheet you are working on, or validate the entire report. You must validate
the report before submitting it.

Go to the top tool bar and click on the drop down box next to the green arrow.

S EDH K BT e® 88 Q

ALP LHCSA STATISTICAL REPOR ORG NAME - 1 (120011234) : STATEWIDE : 2018 : PO1

VALIDATE CURRENT WORKSHEET

C}@ ET_ EI mﬂmns REPORT E |_:'/ @@ @ Q

ALP LHCSA STATISTICAL REPOR ORG NAME - 1 (120011234) : STATEWIDE : 2018 : P01

You can validate a worksheet at any time. You can also refresh the validation after it’s been done once by
clicking the refresh circle in the details portion of the report. Because there are so many worksheets, it may
be easier to validate each worksheet once you’ve finished it. The results of the validation are in a table in the
details section of the worksheet. The message that says “Rule Passed Validation” is only referring to the cell
you are on — not the whole worksheet.

Details

v
Worksheets Open Calculations Text Transfers Validation Results Submission Output
RULE PASSED VALIDATION Current Worksheet Refresh 3
The total of discharges in the “Length of Stay" section must match the total of discharges in the “Discharged To" column in the “Referrals and Discharges™ section. §
{20002.10} EEQ {20004.30} Filter : All Rules. ~| | Export as Excel
Sequence Identifier Level Error Left Value Operator Right Value Rule ‘OriginalLogic

LSR2PATIENT Critical
12 LSR2PATIENT Critical O EEQ
13 LSRZPATIENT  critical | [] EEQ

The total of discharges in the "Length of Stay” section must match the total of discharges in the "Discharged To" column in the "Ref.. |{20002.10} EE...

The unduplicated patient count reported on LSR2 must match the total of unduplicated patients reported on LSR7 - County Forms -... | {20002.3} EEQ.
The number entered as total cases must match the total of the “Referred From" column in the Referrals and Discharges section. {20002.2} EEQ...

IMPORTANT NOTE: The details section is automatically set up to show all rules. It’s only an error if there
is a checkmark in the error box

Sequence Identifier Level Error Left Value ‘Operator Right Value Rule

1 LSRZPATIENT Critical 1.0 EEQ 0 The total of discharges in the "Length of Stay" section must match the total of discharges in the "Discharged To" column

To see if you have any cells with errors — click on the filter in the details section and change it from “all rules”
to “critical errors”.

Details

Worksheets Open Calculati Text Validation Results Submission Output

CRITICAL : Operator [EEQ] : Left and Right values must be exactly equal - {.99} Variance is NOT considered equal.
The total of discharges in the “Length of Stay” section must match the total of discharges in the "Discharged To" column in the "Referrals and Discharges™ section.
{20002.10} EEQ {20004.30}

Current Worksheet

Filter :| Critical Errors

Sequence Identifier Level Errar Left Value Operator Right Value Rule

LSR2PATIENT Critical

The total of discharges in the "Length of Stay" section must match the total of discharges in the "Discharged To" column in the
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Validations can be done for the worksheet you are on by checking the box that says “Current Worksheet” or it
can be done for all worksheets by unchecking the box.
You can fix an error and then re-run the validation by clicking on the refresh circle.

Current Worksheet Refresh ¥
Filter : Critical Errors ~ Export as Excel

If you have passed the validation edits you will have no error boxes checked and get a green message that
says Rule Passed Validation for each cell you choose.

Finalizing the Statistical Report

If you have passed all the validation edits, and you are satisfied with all responses on all forms, click on the
Finalize Report icon.

SBEL E B vauare corrent worksheer - (€ > ©@ £EQ

Or click Action on the top tool bar and choose “Finalize Report”
ol File Edit View Configure Notes Windows Search Help

A message will come up asking if you are sure you want to save and finalize. Click Yes.
A second message will come up directing you to correct errors (if there are any) or letting you know that the
report has been finalized.

Select a location to save your Finalized Report. Make sure that you are aware of where it is being saved
(i.e. desktop) as you will need to find the file when you upload it onto the Healthcare Financial Data
Gateway. You may wish to make a new folder on your desktop and save it there.

You will save a PDF of the report, as well as a .pnp file of the report.

The name of the report will be:
Agency Name (Agency License Number) Statewide 2019 A00.pnp

The file you will want to upload will end in “.pnp”

Your report is now ready to be submitted to the Healthcare Financial Data Gateway.
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Submitting the Finalized ALP LHCSA Statistical Report to the Healthcare Financial Data Gateway

1. Login to the HCS.
2. Click on Healthcare Financial Data Gateway in My Applications. This will take you to the
Healthcare Financial Data Gateway main page.

’L? Healthcare Financial Data Gateway

MNew York State Department of Health Momm | Contscd | el

EVaL EVAL EVAL

Home Software Submmisssons Publications Reports Adrrinistrabcn

Welcome to the Healthcare Financlal Data Gateway
Theit navigation Bar abeve containg seleciabbe ks fof each nclional area of he ApEbeation and i used 1o AEvigats thecughoul the appHCaton.
Please read the descrpbon s of these areas bedow:
Software: The “Software” 1ab is vsed to download the Cost Repot software and supporting documentation. Hems selected for
download will be saved as a nip file
Submissions:  The “Subemissions” tab can be used 1o do aery of the folowing

= Submst your comgleted and inalized Cost Repor
= Wigw the details of past submessions
= Cartify a presously submitted Cost Report

Publications: The “Publications” tab s wsed to download additional information distnbuled by the Depadment of Health that s not
duactly related to the distnbution of the Cost Repoet softwane

Reports: Tha “Repaits” tab is used 16 access 3 downloadable history of submission and cerificatson detads for the Cost Repors
Administration: The "Adeunistration” tab can be used 1o do any of the fallowing

= Grani parmessions bo the applicatians

= Manage Roles

» Set Subsmission CutCf

= Uplaad Softwars, Repars, and Supparting Decurnaent atsan
= Upload Certifications

2014 WS Depariment of Heals

3. Click the Submissions tab — the Submissions page will display

Healthcare Financial Data Gateway o crue iy Bencei

Sl New York State Department of Health Home | Contact | ReguestAccess | Help

Submissions Publications Administration

SUBMISSIONS

Select Cost Report And Organization

Submission Type: | ALP LHCSA [v] Organization: = [(RESANEIN NS [v] Search |

4. Select ALP LHCSA as the Submission Type and your organization from the Organization list and
then click the Search button. The Submission page will be expanded.
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Submissions Publications Administration

SUBMISSIONS

Select Cost Report And Organization

Submission Type:  ALP_LHCSA v Organization: HCBS Test Org Name - 1 (120011234) v Search

New Submission

Email: nancy.simonds@health.ny gov  (Update email address) Refrash Email
Upload File: | Browse...
Submit

Submission History

__ - Report Period :
. Submi Dt siomiter Jsas W]
—Year / Period

5. Click the Browse button to display a dialog box that allows you to locate your finalized ALP LHCSA

Statistical Report. It will have a .pnp file extension.

Once you have selected the file to submit, click the Submit button.

7. The Submission History section of the Submission page will be updated to reflect the status of the
submission.

8. A confirming email message will be sent to the email address listed in the New Submission section of the
Submission page.

@
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Attachment A — Report Tool Bar items

Worksheets

Worksheets

The Worksheets are listed in the Worksheet Panel which is located on the left side of the application
window. Worksheets are listed in alphanumeric order by Worksheet name. Click on a Worksheet to view
that Worksheet in the Matrix Panel. Click on the small arrow key in the top right of the Worksheet Panel to
collapse or expand the panel. Use the "Windows" menu item to organize your Worksheets in the Matrix
Panel.

Title Bar

Title Bar

The Title Bar is located at the very top of the window and will display the name, version and software build
number, followed by the name of the active matrix table if a table is currently open.

E Universal Data Collection Systern - Version 5.0.0 - Build 20130306:152%43 - [FIDA_001_010]

Menu Bar

UDCS Menu bar

File Edit View Configure Action Notes Windows Search Help

The following Help Topics will guide you through the menu bar functionality.

File
The File Menu.
File | Edit View Configure .

Report Manager Ctri+R
New Ctrl+N
Open Ctrl+0
Save Ctrl+5
Save Copy To ... I
Print bl
Close Report i
Exit Program i

Report Manager: Select Report Manager to return to the Report Manager.
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New: This command will start a new Report

Open: This command will enable you to open an existing Report

Save: This will save the Report you are working on.

Save Copy To: The Save Copy window will open and enable you to save a copy of your Report to a location
that you choose.
Y our working report location will remain in the default location: C:\ProgramData\UDCS\report

Print: Two options will be displayed that will enable you to save your Report as a Microsoft Excel
document or a PDF document.

For either option, the Select Worksheets window will open. Check the worksheets you wish to export or
check Select All to check all the worksheets.

You will be prompted to save the export file to a location you choose. You can then open the file from this
saved location and print.

Close Report: Closes the Report. You will be prompted to save your data first.

Exit Program: Closes the UDCS software and the Report Manager. You will be prompted to save your data
first.

Edit
The Edit Menu

Cut, Copy, Paste, Undo

Edit | View Configut
Cut Ctri+X
Copy Ctrl+C
Paste Ctrl+V
Undo Ctrl+Z

These features will enable you to copy data from one part of your report to another, or from Microsoft Excel
to your Report with some limitations:

1) You may copy numeric data to numeric or non-numeric type cells. You may not copy non-numeric data to
numeric type cells.

2) You may not paste data into read only cells such as targets of formulas.

3) You may select a range of cells to copy. However, when you paste the cells, the range size must match. If
the range size does not match, you will not be allowed to copy the data.

For example, if you copy a 5 cell by 5 cell range and try to paste in a 3 cell by 3 cell area, or the area has
read only cells, you will be alerted to adjust your range.
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View
The View Menu

View | Configure Action MNotes Windows 5e

Report Type r
Worksheet Panel (Expand-Collapse) Alt+W

Previous Worksheet Alt+Up

Mext Worksheet Ak +Down
Detail Panel (Expand-Collapse) Alt+D

Calculations (In Pop-Up Viewer)
Text Transfers {In Pop-Up Viewer)
Validation Results (In Pop-Up Viewer)

Submission Output (In Pop-Up Viewer)

Report Type: You can choose to Select All Worksheets to display all the worksheets in the Report in the
Worksheet display panel.

For Reports that have multiple Report Types, you may choose to select only the worksheets from the
selected Report Type.

Worksheet Panel (Expand-Collapse): Expands or collapses the worksheets panel. It may be convenient to
collapse the worksheet panel
when you are working on a large worksheet and could use extra space to see more of the worksheet.

With the worksheets collapsed you may also click on the arrow icon where the worksheets are collapsed to
expand the worksheets.

Previous Worksheet and Next Worksheet: Use these commands to navigate through the worksheets.

Detail Pane (Expand-Collapse): Use this command to expand or collapse the Details panel. This works
similarly to
expand-collapse worksheets.

The following menu items will each open a window that will enable you to Export the data as a text file.
Calculations: A window will open that lists all of the mathematical expressions in the Report.

Text Transfers: Lists all the Text Transfers in the Report.
Text Transfers consist of a value and a target. Once the value is entered, the target will

automatically get populated with the same value.

Validation Rules: Lists all the Validation Rules in the Report.
Validation Rules are conditions that must be met for the report to be completed satisfactorily.
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Submission Output: This is the XML output of the Report. It lists Report configuration information
as well as class code/line numbers and the values that were entered for them.

Configure

The Configure Menu

Configure | Action Notes
Control Data F2

Report Settings F3
Report Types F4

Control Data: Contains information that is required for the Report to be completed correctly and allowed to

be submitted.

All required Control Data fields must be complete. Required fields will have a red exclamation point next to
them.

When you open the Report, you will be alerted if the Control Data information is not completely filled out.

Report Settings / Report Types: These menu items are merely instructions to remind you what to do f you
have created your report using the wrong configuration information, such as the wrong Report Type or wrong
Region. Click on the File menu to Start a New Report. Select the correct settings and then transfer your data
from the incorrect Report to the new Report.

Action

The Action Menu

Action | Notes Windows Sear
Validation Method b

Start Validating F5
Stop Valldating  Ctrl+F5

Finalize Report Fé6

Recalculate Formulas F7

Validation Method: Current Worksheet or Entire Report.

In order to Finalize the Report for Submission you must run it through the validation process. You can
validate to check only the current Worksheet, or you can run Validation for the entire Report. You must
Validate the entire Report in order to pass Validation and have a Finalized Report that is ready to submit.

Start Validating/Stop Validating: Once you have selected to validate the current Worksheet or the entire

Report you can
select the Start Validating item. For larger Reports, you may choose to Stop Validating at any time.
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Notepad
The Notepad Menu
This is a scratch pad to keep notes and provide additional information while you complete your report. Click

the File menu and then Save to save Notes to your Report.
Use the File and Edit menu as you would a typical text editor.

Windows
The Windows Menu
Use the Windows commands to arrange the Worksheets to your satisfaction.

Select the Worksheets command to see a list of opened Worksheets. You may select an open Worksheet to
bring it to the front of the Report.

Windows | Search

Cascade
Horizontal
Vertical

Close All
Worksheets »

Search
The Search Menu
Enter what you would like to search for in the Search box and click the Search button.

All results that match your Search criteria will be listed below. You may choose to Search
the Current Worksheet or All Worksheets by toggling the radio buttons at the bottom of the window.

Help
The Help Menu

View Documentation will open the Help File that you are currently reading.

Help

View Documentation F1

About Universal Data Collection System (UDCS) F12

Click About to open the following window. This information contains details about the Report you have open
as well as the versions of the software and files being used.
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Icon Menu

Icon Menu

Open the Control Data Form.

Start a New Report.

Open an Existing Report.

e B B

Save the Report.

i

Close the Report.

Validate the Current Worksheet or the Entire Report.

Stop the Validation process.

&

Finalize the Report.

[T
i
NI

Open Notepad.

®

Open the Previous Worksheet.
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@ Open the Next Worksheet.

Export the Worksheet as a PDF document.

Export the Worksheet as an Excel file.

Open the Search Window.
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